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Introduction

The purpose of this document is to describe the State and Local Emissions Inventory System (SLEIS) file
import process and flat file specification. It includes standards and conventions to use when
constructing an import file, describes the physical structure of each import file type, and provides basic
instruction on how to create a SLEIS import file.

The contents of this document cover the following file import related topics:

File Import Process Defines the file import process, including an overview and
specifics for each step in the process.

CSV File Format Describes the general design conventions of the Comma
Separated Values (CSV) file format.

Data File Specification Details the flat file specification for each data file type used in
the file import process.

Appendix Specifies data file reference values, and offers brief
instructions on editing CSV file formats.
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File Import Process

Overview

File imports will be initiated and completed using the SLEIS user interface. This interface provides
functionality for:

1) Selecting the emissions report that will receive the contents of the imported data files
2) Invoking the file import process for the selected emissions report
3) Selecting the specific data files to load for the selected emissions report
4) Executing the file import process, which is composed of the following three steps:
a. Data file format validation
b. Business rule validation
c. Database load processing

5) Viewing the results of the file import process, such as data file format errors and business rule
violations

Data File Format Validation

Each SLEIS data file must adhere to a pre-defined comma separated values (CSV) file format. Upon
initiation of the file import process, the following data file format validation processing will be
performed:

1) Validate that header columns in each CSV file are properly named, and that all appropriate
columns exist in the file (refer to the Data File Specification section).

2) Validate that each CSV file line and field is properly formatted (refer to the CSV File Format
section).

3) Validate that each CSV file line can be parsed into individual field values (refer to the Data File
Specification section).

Any data file format validation errors will be displayed to the user within the user interface during the
file import process.

Business Rule Validation

Following successful data file format validation, the business rule engine will process the individual

records extracted from the data file. Relevant business rules will be checked by the system, and any
errors discovered will be displayed to the user within the SLEIS user interface during the file import

process.
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Database Load Processing

Following successful business rule validation, the data extracted from the imported files will be saved to
the SLEIS database. Reference the appropriate Data File Specification section of this document for
additional details.

Data insert and overwrite/replacement for process and emissions data will occur at the unit process
level, and the file import process can be run multiple times for a report, inserting and replacing data as
needed.

For example:
e File import 1 contains emissions data for emission unit A, B, and C
e File import 2 contains emissions data for emission unit C, D, and E

In this case, data for emission unit C would be overwritten by the second file import. Data for emission
units A, B, D, and E would be inserted once, and not overwritten/replaced.

PREPARED BY WINDSOR SOLUTIONS, INC. PAGE 3
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CSV File Format

A CSV data file format will be used to import data into SLEIS. This file format provides for the storage of
structured data in a relatively simple format that can be easily created through automated (e.g.,
exported from a facility’s information system) or manual (e.g., MS Excel, or even a basic text editor)
means.

The CSV file format design conventions used by each SLEIS data file include:

1) Each record will be contained on one line of the file, terminated by a line feed, or a carriage
return and line feed pair, with each field separated by a comma.

2) The first record in the CSV file will contain a column name header in each of the fields.
3) There is no comma following the final field in the record.

4) In case field values have embedded commas, embedded double-quote characters, intentional
leading/trailing space characters, or other reserved characters, fields will always be enclosed
within double-quote characters, whether necessary or not.

5) Leading and trailing spaces or tabs adjacent to commas (not within double-quotes) will be
trimmed.

6) Any embedded double-quote characters must be represented by a pair of double-quote
characters.

For example, a CSV file containing:

“header 1” , “header 2” , “header 3” , “header 4” , “header 5”

“value 17, “”, “value 3, value 3, value 3”7 , ™ value 4 "o, “value “’value”” 5”

Would be processed into individual rows and columns as:

header1 | header 2 header 3 header 4 header 5
value 1 value 3, value 3, value 4 value “value” 5
value 3
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Data File Specification

Since the file import process itself will always be initiated by a user from within SLEIS, where a specific report has already been selected, the

data

files do not require meta-data for report identification (e.g., reporting year, facility identifier, etc.). This data will already be available at the time

of import, and is not needed in the contents of the data file. Specific references to this data are made within the CSV Data File Specification
where appropriate.

The emission report import payload will be composed of the following CSV data files, and will be processed in the order given:
1) Processes.CSV
2) ProcessEmissions.CSV

3) ProcessSupplementalParameters.CSV

Processes.CSV

General business rules:
e  Will not allow import of process emissions with parent emissions units that have been “shutdown” in current reporting year or earlier

e  Will not allow process emissions with unit process last/final inventory year less than current reporting year

Note, all columns must be completed except ones highlighted in grey. The ones highlighted in green are populated from SLEIS during the
template download to help distinguish between records; any data shown in the green fields will be ignored during the import.

Column Header Allowed Values Example Business Rules/Notes Process Emissions Page Field
(Tab: Field Label)

EmissionUnitld Text value EU1 Required. Process: Emission Unit Identifier

The unique emission unit identifier for the
facility.

Processld Text value PR1 Required. Process: Process Identifier

The unique process identifier for the emission
unit for the facility.

PREPARED BY WINDSOR SOLUTIONS, INC.
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Column Header Allowed Values Example Business Rules/Notes Process Emissions Page Field
(Tab: Field Label)
ProcessSCC Text value 10100101 Ignored for import. This field will be populated Process: SCC
after performing a Download Template
operation, but is for information purposes only.
IsReported Text value of: TRUE Defaults to TRUE if not specified. Process: Process is Reported?
e TRUE NOTE: If IsReported value is FALSE, no process
data or process emissions data will be imported
* FALSE for this process (if any has been specified).
SCDHEC Business Rules:
e  Not used. Leave blank.
IsConfidential Text value of: FALSE Defaults to FALSE if not specified. Process: Process is CBI?
e TRUE NOTE: If IsConfidential value is TRUE, throughput
quantity and process emission factors will be
* FALSE treated as confidential business information
(CBI), and not reported to the EPA.
ThroughputQuantity Floating point number 7183.175 Annual Throughput/Process Rate Process: Annual Throughput

SCDHEC Business Rules:

e  Optional. Required if an Emissions
Calculation Method for pollutant emissions
utilizes an emission factor. Refer to
ProcessEmissions.csv file,
CalculationMethod column.

e  Precision and scale (P,S) is limited to (25,10)

ThroughputUnit

Text value*

*Refer to the valid reference values provided by
the agency for this attribute in either the
ReferenceDataValues.CSV file, or by referring to
the equivalent Process Emissions page field
within the application.

SCDHEC Business Rules:
e  Optional. Required if ThroughputQuantity is
specified.

Process: Throughput Unit of Measure

PREPARED BY WINDSOR SOLUTIONS, INC.
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Column Header Allowed Values Example Business Rules/Notes Process Emissions Page Field
(Tab: Field Label)
ThroughputType Text value* *Refer to the valid reference values provided by Process: Throughput Type
the agency for this attribute in either the
ReferenceDataValues.CSV file, or by referring to
the equivalent Process Emissions page field
within the application.
SCDHEC Business Rules:
e  Optional. Required if ThroughputQuantity is
specified.
ThroughputMaterial Text value* *Refer to the valid reference values provided by Process: Throughput Material
the agency for this attribute in either the
ReferenceDataValues.CSV file, or by referring to
the equivalent Process Emissions page field
within the application.
SCDHEC Business Rules:
e  Optional. Required if ThroughputQuantity is
specified.
ional ing th
Comments Text value up to 4000 *  Optiona co'mr.nents/notes regarding the Process: Comments
. process emission record.
characters in length
OpStartTime Time, including AM or 8:00 AM SCDHEC Business Rules: Operations: Standard Start Time
PM e  Not used. Leave blank.
OpStopTime Time, including AM or 5:00 PM SCDHEC Business Rules: Operations: Standard End Time
PM e  Not used. Leave blank.
AvgHrsPerDay Floating point number, 22.5 SCDHEC Business Rules: Operations: Average Hours/Day
>=0 and <= 24 e  Required
e  Precision and scale (P,S) is limited to (3,1)
AvgDaysPerWeek Floating point number, 6.5 SCDHEC Business Rules: Operations: Average Days/Week
>=0 and <=7 e  Required
e  Precision and scale (P,S) is limited to (2,1)
AvgWeeksPerYear Floating point number, 50.53 SCDHEC Business Rules: Operations: Average Weeks/Year
>=0 and <=52 e  Required
e  Precision and scale (P,S) is limited to (3,1)

PREPARED BY WINDSOR SOLUTIONS, INC.
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Column Header Allowed Values Example Business Rules/Notes Process Emissions Page Field
(Tab: Field Label)
ActualDaysPerPeriod Floating point number, 250 SCDHEC Business Rules: Operations: Actual Days/Year
>=0 and <=366 ° Not used. Leave blank.
e  Precision and scale (P,S) is limited to (4,1)
ActualHrsOperation Floating point number 7233 SCDHEC Business Rules: Operations: Actual Hours/Year
>=1 and <= 8784 e  Required
e  Precision and scale (P,S) is limited to (5,1)
DecToFebPercent Floating point number, 24.5 SCDHEC Business Rules: Operations: Season Operations
>=0and <= 100 e  Required December-February (%)
e  Precision and scale (P,S) is limited to (4,1)
e  Total seasonal % must be between 99.5 and
100.50r0
o If AvgWeeksPerPeriod > 39 then all seasonal
%'s are required are required to be > 0%
o If AvgWeeksPerPeriod > 26 then then at
least three seasonal %’s are required to be >
0%
o If AvgWeeksPerPeriod > 13 then then at
least two seasonal %’s are required to be >
0%
MarToMayPercent Floating point number, 255 SCDHEC Business Rules: Operations: Season Operations
>= 0 and <= 100 e  Required March-May (%)
e  Precision and scale (P,S) is limited to (4,1)
e  Total seasonal % must be between 99.5 and
100.50r0
o If AvgWeeksPerPeriod > 39 then all seasonal
%'s are required are required to be > 0%
o If AvgWeeksPerPeriod > 26 then then at
least three seasonal %’s are required to be >
0%
o If AvgWeeksPerPeriod > 13 then then at
least two seasonal %’s are required to be >
0%
JunToAugPercent Floating point number, 25 SCDHEC Business Rules: Operations: Season Operations

>=0and <= 100

e  Required

June-August (%)

PREPARED BY WINDSOR SOLUTIONS, INC.
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Column Header

Allowed Values

Example

Business Rules/Notes

Process Emissions Page Field
(Tab: Field Label)

Precision and scale (P,S) is limited to (4,1)
Total seasonal % must be between 99.5 and
100.50r0

If AvgWeeksPerPeriod > 39 then all seasonal
%'s are required are required to be > 0%

If AvgWeeksPerPeriod > 26 then then at
least three seasonal %’s are required to be >
0%

If AvgWeeksPerPeriod > 13 then then at
least two seasonal %’s are required to be >
0%

SepToNovPercent

Floating point number,
>=0and <= 100

25

SCDHEC Business Rules:

Required

Precision and scale (P,S) is limited to (4,1)
Total seasonal % must be between 99.5 and
100.50r 0

If AvgWeeksPerPeriod > 39 then all seasonal
%'s are required are required to be > 0%

If AvgWeeksPerPeriod > 26 then then at
least three seasonal %'s are required to be >
0%

If AvgWeeksPerPeriod > 13 then then at
least two seasonal %’s are required to be >
0%

Operations: Season Operations
September-November (%)

TotalOzoneSeasonDays

Integer, 0-153

153

Days operated May-September.

SCDHEC Business Rules:

Optional

If June-August (%) is > 0 then the Total
Ozone Season Days must be > 0 (ignored if
no value)

If the March-May (%) is not > 0 and June-
August (%) is not > 0 and September-
November (%) is not > 0, the Total Ozone
Season Days cannot be > 0 (ignored if no
value)

Operations: Total Ozone Season Days

(May-September)

PREPARED BY WINDSOR SOLUTIONS, INC.

PAGE9




SLEIS | FILE IMPORT SPECIFICATION FOR BATCH IMPORTS

SCDHEC Business Rules:
e Not used. Leave blank.

Column Header Allowed Values Example Business Rules/Notes Process Emissions Page Field
(Tab: Field Label)
. If specified, must be >=0 and <= 153
TotalSummerSeasonDays Integer, 0-92 92 Days operated June-August. Operations: Total Summer Season Days
SCDHEC Business Rules: (June-August)
. Not used. Leave blank.
TotalCOSeasonDays Integer, 0-91 91 Days operated December-February. Operations: Total CO Season Days

(December-February)

PREPARED BY WINDSOR SOLUTIONS, INC.
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ProcessEmissions.CSV

General business rules:

e At least one pollutant must be specified for each process reported in the Processes.csv file
e Pollutants cannot be duplicated (reported twice) for the same emission unit and process

Note, all columns must be completed except ones highlighted in grey.

Column Header

Allowed Values

Example

Business Rules/Notes

Process Emissions Page Field
(Tab: Field Label)

EmissionUnitld

Text value

EU1

Required.

Unique emission unit identifier for the facility.
Used as pseudo key along with Processld to the
corresponding Processes.CSV record.

Process: Emission Unit Identifier

Processld

Text value

PR1

Required.

Unique process identifier for the facility. Used as
pseudo key along with EmissionUnitld to the
corresponding Processes.CSV record.

Process: Process Identifier

PollutantCode

Text value*

NOX
OR
000071432

Required.

*Refer to the valid reference values provided by
the agency for this attribute in either the
ReferenceDataValues.CSV file (search for
PollutantCode in the AttributeName column), or
by referring to the equivalent Process Emissions
page field within the application.

Emissions: Pollutant Code

CalculationMethod

Text value*

28

Required.

*Refer to the valid reference values provided by
the agency for this attribute in either the
ReferenceDataValues.CSV file (search for
CalculationMethod in the AttributeName
column), or by referring to the equivalent Process
Emissions page field within the application.

Emissions: Calculation Method

EmissionFactor

Floating point number

3.3579

In Lbs per EmissionFactorUnit

Emissions: Emission Factor (Lbs/Unit)

PREPARED BY WINDSOR SOLUTIONS, INC.
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Column Header

Allowed Values

Example

Business Rules/Notes

Process Emissions Page Field
(Tab: Field Label)

SCDHEC Business Rules:

e  Required if CalculationMethod code is NOT
‘1,2’,3", ‘4,5, ‘6", or ‘7’

e Not allowed (leave blank) if
CalculationMethod codeis ‘1’, ‘2’, ‘3’, ‘4, 'Y,
‘6’,or ‘7’

e  Precision and scale (P,S) is limited to (28,15)

EmissionFactorUnit

Text value*

*Refer to the valid reference values provided by
the agency for this attribute in either the
ReferenceDataValues.CSV file, or by referring to
the equivalent Process Emissions page field
within the application.

NOTE: The EmissionFactorUnit value supplies the
denominator of the implied “Lbs” per
EmissionFactorUnit of the EmissionFactor value.

SCDHEC Business Rules:

e  Required if CalculationMethod code is NOT
lll’ IZI’ 13” I4II 15’, ’6’, or 17!

e Not allowed (leave blank) if
CalculationMethod code is ‘17, ‘2’, ‘3’, ‘4", 'Y,
‘6’, or ‘7’

Emissions: Emission Factor Unit

EmissionQty

Floating point number

2978.45678

Required.
Estimated emissions in Tons.

NOTE: If a CalculationMethod is specified that
requires an EmissionFactor and
EmissionFactorUnit, AND the EmissionFactorUnit
matches the Processes.csv Throughput Unit, the
EmissionQty will be calculated upon import, and
the EmissionQty from the import file will be
ignored.

If CaclulationMethod is specified that DOES NOT
require EmissionFactor, EmissionFactor and

Emissions: Estimated Emissions (Tons)

PREPARED BY WINDSOR SOLUTIONS, INC.
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Column Header

Allowed Values

Example

Business Rules/Notes

Process Emissions Page Field
(Tab: Field Label)

EmissionFactorUnit cannot be specified, and
EmissionQty must be specified.

SCDHEC Business Rules:
e Mustbe>=0
e  Precision and scale (P,S) is limited to (28,15)

characters in length

emission record.

StackTestDate Date format SCDHEC Business Rules: Emissions: Stack Test Date
e Not used. Leave blank.
Comments Text value up to 4000 Optional comments/notes regarding the process Emissions: Comments

PREPARED BY WINDSOR SOLUTIONS, INC.
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ProcessSupplementalParameters.CSV

General business rules:

e Thisis an optional import file
e Values entered will be validated based on configurations stored in the database for each parameter (variable). For example, fields that are
percentages must be a valid number greater than 0 and less than or equal to 100.

Column Header Allowed Values Example Business Rules/Notes Process Emissions Page Field
(Tab: Field Label)
EmissionUnitld Text value EU1 Required. Process: Emission Unit Identifier
Unique emission unit identifier for the facility. Used
as pseudo key along with Processld to the
corresponding Processes.CSV record.
Processld Text value PR1 Required. Process: Process Identifier
Unique process identifier for the facility. Used as
pseudo key along with EmissionUnitld to the
corresponding Processes.CSV record.
ParameterCode Text value A Code identifying the supplemental parameter. Process: Supplemental Calculation
Parameters
ParameterName Text value % Ash Ignored for import. This field will be populated after Process: Supplemental Calculation
performing a Download Template operation, but is Parameters
for information purposes only.
Value Floating point number 2.6 Required Process: Supplemental Calculation

Parameters
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Appendix

Reference Data Values

Reference data used to validate values within the imported data files is specific to each agency, and is
not documented within this specification. The Download Template function will generate the following
CSV files:

1. Processes.CSV

Data from the currently selected facilities’ reports, formatted per specification in the Data File
Specification section for this CSV file type.

2. ProcessEmissions.CSV

Data from the currently selected facilities’ reports, formatted per specification in the Data File
Specification section for this CSV file type.

3. ReferenceDataValues.CSV (see below)

A reference file that contains the list of allowed values that are used in order to pass validation
rules per the specification in the Data File Specification for any CSV file type.

Column Header Example Comments/Notes

AttributeName AnnThroughputUnit Corresponding column header/attribute name as documented in the
data file specification.

Value GAL Code/value to input into the import data file.
Description GALLONS Descriptive text of the code/value specified in the value column.
Notes Additional descriptive text or instructions on the attribute value.

4. ReferenceThroughputValues.CSV (see below)

A reference file used to select a valid throughput combination for the Processes.CSV file. It
contains the list of valid throughput combinations based on Source Classification Code that are
used in order to pass validation rules. To use, find the SCC number of the Process, select the
correct ThroughputUnit, ThroughputType, and ThroughputMaterial (columns B, C, and D), then
copy and paste them into Processes.CSV file (columns F, G, and H).

Column Header Example Comments/Notes

scc 10100101 The Source Classification Code value. Search this column for the SCC
for which allowed throughput combinations are needed.

ThroughputUnit TON Throughput unit of measure code to input into the import data file.

ThroughputType | Throughput type code to input into the import data file. | = Input, O =
Output, E = Existing

ThroughputMaterial | 640 Throughput material code to input into the import data file.

MaterialType Anthracite Descriptive text of the throughput material name. It will not be used

in the import data file, but will be used as a reference when selecting
material code (above).
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Editing CSV Files

Ideally, generation of SLEIS-compatible CSV files will be handled programmatically through a facility’s
existing information system(s) or possibly through Microsoft Excel macros/scripting.

For manual editing of the CSV files, the default editor for most users will likely be Microsoft Excel, which
recognizes the CSV file format and automatically loads and formats the data. Any text editor may also be
used (e.g., Notepad, etc.) to edit CSV files, as well as any number of free CSV file editors found online.

Note that one significant limitation of editing CSV files with Microsoft Excel is that an undesired data
conversion will occur when opening a CSV file with leading O’s (zeros) in alpha-numeric fields. For
example, a process name, or code value with all numeric values will be converted to a numeric value
with leading zeros removed upon opening the file. This can cause values such as ‘001’ to be
converted to the number 1 (no leading zeroes).

To edit a CSV file in MS Excel without having leading zeros removed from fields, perform the following

steps:

LN

Extract the individual .CSV files from the .ZIP file generated using the Export or Download
Template function to your local system (e.g., C:\Users\[username]\Desktop)

Open the MS Excel application (Note: NOT by double-clicking the file, just open the application
itself)

Click on the Data tab

On the Data tab, in the Get External Data section, click From Text on the ribbon bar. A file
selection dialog will be opened.

Navigate to where you saved the files and select one (e.g., Processes.csv), then click Import. The
Text Import Wizard dialog is opened.

Click the box next to the text My data has headers.

Ensure the Delimited file type option is selected, then click Next.

Ensure Comma is the only item selected in the Delimiters section and click the Next button.

In the Data Preview section, select the field that could contain leading zeros (e.g., the
EmissionUnitld and Processld columns) and select the Text option in the Column data

format section. Repeat for all columns that could contain leading zeros you want to retain in the
value.

10. Click Finish.

Note: The file can then be edited and saved as an MS Excel document, but before importing it into SLEIS,
you will need to save as .CSV file format (through File -> Save As dialog in MS Excel, choose .csv file
format).
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